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1. About the License Server 

The MotorXP-PM/AFM License Server is designed to work with floating 

licenses without being tied to the physical addresses of computers. Purchasing 

one server license for n workstations allows you to work from any computer 

in the corporate network that has access to the license server. The number n 

is determined by the number of licenses purchased. At any given time, no 

more than n computers can be connected to the license server. If the maxi-

mum number of clients (computers) is connected to the license server, new 

clients will not be able to connect until at least one license becomes available 

on the server. 

Multiple MotorXP-PM/AFM client applications can connect to the license 

server from the same computer. In this case, only one license will be used on 

the server, regardless of how many MotorXP-PM/AFM client applications are 

connected to the license server from the same computer (host). 

Figure 1 shows the main window of the License Server and the Network 

License Manager. 

 

Figure 1. Main window of the License Server PM/AFM and the MotorXP-PM/AFM  

Network License Manager 
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Advantages of floating licenses: 

1. Flexibility: Licenses can be used by different users at different times. 

2. Cost savings: There is no need to purchase a license for each device; 

it is sufficient to have licenses for the maximum number of simultaneously 

working users. 

3. Centralized management: The administrator can manage connected 

clients through the license server. 

Disadvantages of floating licenses: 

1. Dependency on the server: If the license server is unavailable, users 

will not be able to access the full functionality of the MotorXP-PM/AFM soft-

ware. 

2. Limitation on simultaneous use: If all licenses are in use, new users 

will not be able to connect to the server. 

It is important to plan the number of licenses according to your organi-

zation's needs. 

 

 

The application interfaces shown in the figures in the User Guide may differ slightly from 

the current user interface design of the MotorXP-PM/AFM applications and the License 

Server. 

 

Thank you for using MotorXP, License Server and reading this manual. 
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2. Downloading and Installing the License Server 

 To install the License Server PM/AFM, you need to download the 

MotorXP-PM/AFM application installer. The installer can be downloaded from 

the official website https://motorxp.com/downloads/. After downloading the 

installer, you need to run it and perform the installation. The license server 

executable file (LicenseServer.exe) is included in the basic installation. After 

installing the MotorXP-PM/AFM application, the license server executable file 

LicenseServer.exe is located in the <installation_folder_path>/bin folder 

(Figure 2). Additionally, there is a standalone installer available for setting up 

the License Server PM/AFM. Please contact us via email: info@motorxp.com. 

 

Currently (March 2025), the MotorXP-PM/AFM application can 

be installed by extracting the archive. 

 

 

Figure 2. LicenseServer.exe executable file 

 

 

The License Server can be run on a dedicated computer or on a personal computer where 

the MotorXP -PM/AFM client application is planned to be used. It is also possible to run 

two separate license servers on the same computer to activate MotorXP-PM and 

MotorXP-AFM applications. 

 

  

https://motorxp.com/downloads/
https://mailto:info@motorxp.com
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3. Starting and Activating the License Server 

To obtain the server license file, you need to email: info@motorxp.com. 

The following information is required to generate the license: the MAC address 

of the computer on which the license server will be run, the required number 

of available licenses, the version of the MotorXP (PM/AFM) application, and 

the license type (Matlab, Standalone, Combo). 

Below are the steps to start and activate the License Server for the 

MotorXP-PM client applications: 

Step 1: Double-click the LicenseServer.exe executable file located in 

the <installation folder path>/bin folder (Figure 3.1). 

 

Figure 3.1. LicenseServer.exe executable file 

 

 

After running the LicenseServer.exe executable file, a warning from Windows Security and 

Windows Defender Firewall will appear. You need to read the information and click the 

"Allow access" button (Figure 3.2). 

 

The main application window will also appear, prompting you to activate 

the server license (Figure 3.3). The license can be activated immediately after 

starting the server (click 'Yes' in the dialog box) or later through the menu 

(select Licensing > Network License Manager). By default, the license server 

for the PM version listens on port 43101. If you encounter the error message 

'Unable to start the server', refer to Chapter 4. 

https://mailto:info@motorxp.com
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Figure 3.2. Windows Security Alert 

 

 

Figure 3.3. Main window of the LicenseServer.exe application 

 

Step 2: Click the 'Yes' button in the dialog box (Figure 3.3) or select 

the Licensing option in the menu bar. After performing this action, the 

MotorXP-PM Network License Manager will open (Figure 3.4). 

 

 

Currently (March 2025), the license server can only be activated using a license file; online 

activation is not available. The license manager window displays the licensing status. 
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Figure 3.4. Network License Manage Window 

 

Step 3: Click the 'Setup License from file' button, and select the 

server license file with the *.mxp extension using the file explorer. The license 

manager window will display the current licensing status (Figure 3.5). To apply 

the changes, close the Network License Manager window.  

 

Figure 3.5. Network License Manage Window After Loading the License File 

 

Step 4: To activate the last loaded server license, you also need to 

restart the License Server. After closing the license manager, a dialog box will 

appear prompting you to restart the License Server (Figure 3.6). 

 
Restarting the license server will disconnect all connected clients. 
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Figure 3.6. Dialog Box "Restart Server to Activate License" 

 

Step 5: After restarting the license server, the main application window 

will appear. The status bar will show the current licensing status and the li-

cense type (e.g., Combo). In Figure 3.7, the server license is designed for 

simultaneous connection of 5 computers. 

 

 

Figure 3.7. Main Window of the LicenseServer.exe Application 

 

Step 6: The license server is activated and ready to accept connections. 

You can now close the main license server window (click the X in the upper 

right corner of the window), and the server will continue to run in the back-

ground, with the main window minimized to the system tray. 

The license server icon will appear in the notification area (system tray). 

To display the context menu with actions, right-click the license server icon. 
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You can show/hide the main application window by double-clicking the license 

server icon in the system tray (Figure 3.8). 

 

 

Figure 3.8. LicenseServer.exe Icon in the Notification Area 
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4. Configuring the License Server 

To enable interaction between the MotorXP-PM/AFM client application 

and the License Server, configuration is required. Typically, running the 

LicenseServer executable file is sufficient for normal operation of the license 

server, and no additional server configuration is required. Server configuration 

is necessary if the default port is already in use by another program 

(application). For the license server to work and process client connections, a 

free port is required. 

 

 

The default port for the PM version of the license server is 43101, and for the AFM version, 

it is 43102. 

 

If the port is already occupied by another application, an error message 

will appear after starting the license server or when changing the port in the 

settings (Figure 4.1). 

 

 

Figure 4.1. Error message when trying to occupy a port 

 

To resolve this error, you need to configure the server. If you need to 

initially start and activate the License Server, refer to Chapter 3. 

Let's consider the steps for configuring the License Server for client 

applications and issuing floating licenses after starting and encountering port 

issues: 

Step 1: Open the server settings window through the tray (Figure 4.2a), 

the menu bar (Edit > Settings), or the toolbar (Figure 4.2b). 
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a b 

Figure 4.2. Opening server settings: a – in the tray; b – in the main window 

 

Step 2: Specify the value of a free port for listening. The port number 

must be in the range from 1024 to 65535 (Figure 4.3). 

 

Figure 4.3. Settings dialog box 

 

Step 3: Click the 'OK' button in the server settings dialog box. 

Step 4: If the license server successfully occupies the specified port, a 

notification will appear (if notifications are enabled, Figure 4.4). If the server 

fails to occupy the port for listening, an error message will be displayed (Figure 

4.1), so you should repeat steps 1-3. The listening port number is displayed 

in the tooltip when hovering over the application icon in the notification area. 

 

Figure 4.4. Notification about port listening 

 

Step 5: The process of activating the server license is described in 

Chapter 3. Server license activation is required during the initial server starts 

or when the license expires. 

The launch, settings, and activation of the License Server are complete. 
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5. Configuring the MotorXP-PM/AFM Client Application 

Configuring the MotorXP-PM client application is a mandatory step for 

working with a floating license. Let's consider the steps for configuring the 

MotorXP-PM client application to connect to the License Server: 

Step 1: Launch the MotorXP-PM application and find the Licensing > 

License Manager option in the menu bar (Figure 5.1). 

 

 

Figure 5.1. Main window of the MotorXP-PM application 

 

Step 2: Click on the License Manager option. In the opened license 

manager window, select the 'Server license' option if it is not already set 

(Figure 5.2). 

 

 

The license manager window displays information about the license type and the client 

host. In Figure 5.2, you can see that there is no connection to the license server 

(connection status – Offline). 
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Figure 5.2. MotorXP-PM License Manager Window 

 

Step 3: Click the 'Configure server license' button. In the configura-

tion window, fill in the 'Address' field by specifying the IP address of the 

computer where the license server is running or the DNS name. Also, specify 

the port number used by the License Server (Figure 5.3).  

 

 

Figure 5.3. Configuring the connection to the license server 
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Step 4: Check the ability to connect to the license server by clicking the 

'Check connect' button. If successful, the message Connection to server 

successful will be displayed (Figure 5.4a), and if unsuccessful, the message 

Connection to server failed will be displayed (Figure 5.4b). If the connec-

tion check fails, perform the following actions: 

- ensure that the specified IP address, DNS name, and listening port 

number are correct;  

- make sure that the license server is running. At this stage, it does not 

matter whether the license is activated on the server or not; 

- check the status of the license server in the tray (see Chapter 7): 

normal mode ( ), error state ( ), action required ( ). It is possible that the 

license server failed to occupy the port, and its value needs to be changed in 

the settings (see Chapter 4); 

- check the visibility of the license server in the corporate network by 

running the ping <license server IP address>/<DNS name> command in the 

command line; 

- configure the firewall. On the client computer, you need to allow out-

going network traffic. On the server computer, you need to allow incoming 

network traffic on the listening port (by default, for the PM version – 43101, 

for AFM – 43102) (see Chapter 9). 

 

  

a b 

Figure 5.4. License server connection status: a – success; b – failure 
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Step 5: Click the 'OK' button in the settings dialog box and close the 

License Manager Window to apply the changes (click the X in the upper right 

corner of the license manager window). 

 

Step 6: To connect to the License Server and activate the full function-

ality of the MotorXP-PM client application, you need to load the file (Figure 

5.5a) or restart the MotorXP-PM application (Figure 5.5b). 

 

  

a b 

Figure 5.5. Launching the MotorXP-PM application with an activated license: a – launching 

the application without loading a file; b – activation view with a loaded file 

 

If the connection to the license server is successful and the application 

is activated, the FREE Edition label in the title bar will be replaced with Pro. 

Also, in the Command Window in the Matlab application window, the 

following entry will appear: read license from server <IP address>:port 

successed. If the license activation fails, the following entry will appear in 

the Command Window in the Matlab application window: read license from 

server <IP address>:port failed. 

 

 

License activation failure may be due to the fact that there are no free licenses on the 

server at the time of the request, or the application version (PM, AFM) and license type 

(Matlab, Standalone, Combo) of the server and the client application do not match. 

 



License Server PM/AFM. User Manual 

 

16 
 

The PM version License Server can only issue licenses for MotorXP-PM 

client applications (the same approach applies to AFM). 

A server with a Combo license type can issue licenses for client applica-

tions with Matlab, Standalone, and Combo license types. If the server license 

type is Matlab, the clients must also have the Matlab type (the same approach 

applies to Standalone). 

 

 

The firewall may filter network traffic. On the client computer, you need to allow outgoing 

network traffic. On the server computer, you need to allow incoming network traffic on 

the listening port (by default, for the PM – 43101, for AFM – 43102) (see Chapter 9). 

 

As a result of performing the steps presented in Chapters 3-5, the li-

cense server and the MotorXP-PM/AFM client application have been launched, 

activated, and configured. At this stage, the application setup is complete. 
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6. Stopping the License Server 

To stop the License Server, you need to exit it using the 'Exit' action 

located in the notification area, menu bar (File > Exit), or toolbar (Figure 6.1). 

  

a b 

Figure 6.1. 'Exit' action: a – in the tray; b – in the menu bar and toolbar 

 

 

When stopping the license server, all connections with connected MotorXP-PM/AFM 

client applications are terminated (Figure 6.2). 

 

 

Figure 6.2. Warning about disconnecting clients 

 

Also, make sure that the 'Start License Server on system startup' 

option is not enabled in the server settings (Figure 6.3). 

 

 

Figure 6.3. 'Start License Server on system startup' option in the server settings 

 

 

If this option is enabled, the license server will automatically start when the computer on 

which the server is running is started/restarted. 
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7. Main Functionality and Features of the License Server 

 Let's consider the functionality of the license server and the main ele-

ments of the user interface. 

 

Main application window 

The license server mainly works in the background and displays the op-

erating status in the tray and by sending notifications (Figure 7.1). You can 

show the minimized main application window in two ways: 

1. Double-click the left mouse button on the license server icon in the 

tray (Figure 7.1a). The application icons in the notification area may be hid-

den, so you need to click the arrow to expand the grouped icons and find the 

license server icon. 

2. Click the 'Connections' action in the context menu in the tray. To 

open the context menu, right-click on the license server icon in the tray (Fig-

ure 7.1b). 

2

1

 

2

3

1

 

a b 

Figure 7.1. Working with the license server through the tray: a – double-click the left mouse 

button; b – context menu 

 

The main application window has 5 elements: 

Element 1. Title bar. The title bar indicates the version type of the li-

cense server – PM or AFM (Figure 7.2). If you click the X in the upper right 

corner of the window, the main application window will be minimized, and the 

server will continue to run in the background (minimized to the tray). 

1

 

Figure 7.2. Title bar 
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Element 2. Menu bar. The menu contains the following standard items: 

File, Edit, Licensing, Help (Figure 7.3). 

 

Figure 7.3. Menu bar 

 

Menu items and actions: 

File 

> Restart       (Restart the license server).  

> Exit        (Stop the license server and exit the application). 

Edit 

> Settings .     (License server settings dialog box). 

Licensing  

> Network License Manager       (Server licensing). 

Help  

 > Manual (This is the user manual ). 

> About (About the license server). 

 

Element 3. Toolbar. The actions are the same as in the menu bar (Fig-

ure 7.4). 

 

Figure 7.4. Toolbar 

 

Element 4. Table with a list of connected hosts. The table is located in 

the center of the main application window. 

 

Element 5. Status bar. The status bar on the left side indicates the 

server license status (Not Activated, Expired, In use) and on the right side 

shows the server license type (Matlab, Standalone, Combo) with the server 

version number (e.g., Ver. 2024.11) (Figure 7.5). 

 

Figure 7.5. Status bar 
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License Server Settings 

You can open the license server settings window in two ways: 

1. In the main window, select the 'Settings' action in the toolbar ( ) 

or in the menu bar (Edit > Settings). 

2. Click the 'Settings' в action in the context menu in the tray. To open 

the context menu, right-click on the license server icon in the tray. 

In the license server settings, you can perform two actions (Figure 7.6): 

1. Change the port number for listening (1). The port number must be 

in the range from 1024 to 65535. 

2.  Enable/disable the option to automatically start the server (2). 

To save and apply the settings, click the 'OK' button in the dialog box.  

 

1

2

 

Figure 7.6. Settings dialog box: 1 – field for entering the port number; 

2 – autostart option 

 

Viewing the list of connected hosts 

You can view the list of connected hosts in the main application window. 

Information about connected hosts is displayed in the table (Figure 7.7), which 

has 4 columns: hostname (1), logical address (IP address) (2), number of 

connected MotorXP-PM/AFM client programs (3), duration of the host's con-

nection to the license server for one session (4). 

 

1 2 3 4

 

Figure 7.7. Table with a list of connected hosts 
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Forcibly disconnecting a host (computer) from the license 

server 

To disconnect a host from the license server, you need to: 

Step 1: Open the main License Server application window. 

Step 2: Find the entry in the table with the IP address/host name of the 

host to be disconnected. 

Step 3: Right-click on the row (entry) to display the context menu and 

select the 'Disconnect host from license server' action (Figure 7.8).  

Alternative step 3: You can also click on the desired row in the table and 

then press the 'Delete' key on the keyboard. 

Answer the clarification questions with 'Yes' (Figure 7.9). 

 

 

Figure 7.8. Context menu with the disconnect action 

 

 

Figure 7.9. Question "Do you want to disconnect the host from the server?" 



License Server PM/AFM. User Manual 

 

22 
 

Activating the server license in the Network Manager 

The network license manager is used to activate the server license using 

a file (online activation is not available as of March 2025) and to inform about 

the current license status. Detailed information about the Network License 

Manager is provided in Chapter 3. 

 

License Server operating states 

The license server has three operating states: 

State 1. Normal mode. 

Description: Normal operating mode of the license server. The server 

can accept client connections. 

Icon: Default server icon (Figure 7.10a). 

 

State 2. Action required. 

Description: This state occurs when the license file is changed through 

the network manager and the server license needs to be activated. 

Icon: Server with a yellow circle (Figure 7.10b). 

Actions to return to normal mode: Restart the license server through 

the tray (right-click on the license server icon in the tray to open the context 

menu, select the 'Restart' action). 

 

State 3. Error state. 

Description: In the error state, the License Server cannot accept client 

connections. 

Icon: Server with a red circle (Figure 7.10c). 

Actions to return to normal mode: Change the port number in the license 

server settings (right-click on the license server icon in the tray to open the 

context menu, select the 'Settings' action, see Chapter 4). 

   

a b c 

Figure 7.10. Application icons: a – normal mode; b – action required; 

c – error state 
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License Server statuses 

The server license can be in 4 statuses: 

Status 1. Not activated (Not Activated). 

Status 2. Activated (Activated). 

Status 3. Less than a week left until the license expiration date (Almost 

Expired). 

Status 4. The license has expired (Expired). 

The current server license status is displayed in the status bar in the 

main application window and in the tooltip that appears when hovering over 

the application icon in the tray. 

 

 

Starting one week before the license expiration date, the server will send daily 

notifications. This notification is sent once a day. 

 

Notifications 

Since the license server primarily runs in the background, the applica-

tion includes a notification system. 

 

 

To receive notifications from the license server, you need to enable notifications in the 

operating system's notification manager. 

 

Table 1 lists the possible notifications from the License Server. 

 

Table 1 – List of notifications from the License Server 

№ Name Example Category 

1 Background Mode 

 
Information 

2 Port Listening 
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Table 1 Continued. 

№ Name Example Category 

3 

The new license will 

be applied after  

restart 
 

Information 

4 
Server Running with 

Inactive License 

 

Warning 
5 License Expired 

 

6 

Less than<X> Days 

Left Until License  

Expiration 
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8. Example of Interaction Between the App and the Server 

Let's look at an example of how multiple MotorXP-PM client applications run-

ning on different computers interact with a License Server on a local network. We’ll 

assume that the License Server and client applications are already configured. 

 
The first host (computer), DESKTOP-UM4K514, has the IP address 192.168.1.43 (in 

Figure 8 – 127.0.0.1). We’ll start the License Server on this computer. We’ll also launch two 

MotorXP-PM client applications on the same computer, both using the Standalone license type. 

The second host (computer), veksoft, has the IP address 192.168.1.20. On this com-

puter, we’ll launch three MotorXP-PM client applications — two using the Matlab license type 

and one using the Standalone license type. 

 

Figure 8 shows the main window of the License Server. As you can see, the 

license server has a total of 5 MotorXP-PM client applications connected, running on 

two hosts (labeled as number 1 in the figure). 

In the figure, the area labeled as number 2 shows the number of licenses 

currently in use. In this case, 2 licenses are in use because client applications from 

two computers are connected to the license server. 

The area labeled as number 3 displays the type of server license and the 

server version. Here, the server license type is Combo, which means the server can 

work with client applications that have Combo, Standalone, or Matlab license types. 

 

1

2 3

 

Figure 8. Table with connected hosts 
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9. Troubleshooting Possible Issues 

 In progress... 


